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Digital Dictation

EINLEITUNG

Digital Dictation ist ein umfassendes Software/Hardware-Paket fir Microsoft
WindowsTM zur Steuerung der Wiedergabe von digitalen Audiodateien Uber
das mitgelieferte Digital Dictation Ful3pedal plus Software.

DD1 ist die perfekte Ergdnzung zu den Marantz Professional Solid State Recordern,
wie z. B. PMD670/671, fur alle Anwendungen, bei denen Sprache aufgenommen und
niedergeschrieben wird.

Mit der Digital Dictation Software kénnen digitale Dateien, die z. B. mit dem PMD670/671
aufgenommen wurden, Uber einen Microsoft Windows PC abgespielt werden, wobei das
mitgelieferte FuRBpedal auf genau die gleiche Weise wie bei einem normalen Diktiergerat
zur Steuerung des Transports dient.

Diese Bedienungsanleitung beinhaltet die einzelnen Schritte zur Installation der Software,
die Beschreibung der einzelnen Funktionen und Problemlésungen bei Fehlermeldungen.

Weitere Informationen unter: http://www.dig-dictation.com
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1 SYSTEMANFORDERUNGEN

Systemanforderungen fiir die Digital Dictation Software:

Pentium Il 400 oder hoher.
64 Mb memory (128Mb fur Windows XP).

10 Mb freie Hard Disk.
1 freier USB port.

Digital Dictation ist kompatibel mit:

- Microsoft Windows 2000
- Microsoft Windows XP

Altere Versionen wie:

- Microsoft Windows 3.1x
- Microsoft Windows 95
- Microsoft Windows 98
- Microsoft Windows ME
- Microsoft Windows NT

Werden nicht unterstitzt.
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2 INSTALLATION

Erster Schritt:
Bitte schliel}en Sie das FuBpedal an einen freien USB Port an Ihrem Rechner an.
Windows wird das FuBpedal automatisch registrieren.

Um Digital Dictation zu installieren, mussen Sie Administratorrechte haben.
Sollte dies nicht der Fall sein, wenden Sie sich bitte an Ihren Systemadministrator.

Bitte legen Sie die beiliegende CD in das CDROM oder DVDROM Laufwerk ein.

Das folgende Fenster erscheint automatisch auf dem Bildschirm.
Sollte dies nicht der Fall sein, 6ffnen Sie die CDROM und klicken Sie “autorun.exe”.

=
Mennegat Trading

digital.dictation

Install Digital Dictation
"n.l"iaw Manual
‘u"'snte Website

i WINAMP ==-7nnt SHENEM 2 | &>

Sie kénnen unter folgenden 4 Optionen auswahlen:

- Install Digital Dictation
startet die Installation
- View Manual
o6ffnet Handbuch als PDF
- Visite Website
Offnen der Digital Dictation website
- Quit

Beenden der installation.

Offnen Sie “Install Digital Dictation” um Digital Dictation auf lhrem Computer zu
installieren.
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Zur BegruBung erscheint folgendes Fenster:

Installer Language x|

Please select the language of the installer

v
Ik I Cancel |

Wahlen Sie die gewlnschte Sprache aus und bestatigen Sie um fortzufahren mit “OK*.

Digital Dictation Lizenzabkommen:

ji Digital Dictation Installation: Lizenzak men =101

Bitte lesen Sie das Lizenzabkommen, bevor Sie Digital Dictation installieren.
Wenn Sie alle Bedingungen des Abkommens akzeptieren, kicken Sie auf
Annehmen,

s
Deutsche Dbersetzung der ﬂ
GMU General Public License

Irspringlich erstellt im Auftrag der 5.u.5.E. GmbH — htto: (fwww . suse, de
von Katja Lachmann Ubersetzungen,

(berarbeitet von Peter Gerwinski, G-M-J GmbH — htp: [ fwww.g-n-u.de
(31. Oktober 1998, 4. Juni 2000)

Diese Ubersetzung wird mit der Absicht angeboten, das Verstindnis der GNU
General Public License (GMU GPL) zu erleichtern. Es handelt sich jedoch nicht LI

1im rine nffiFielle nder im rechlichen Sinne anerkannte [Thersetzinn.

Abbrechen | Mullsaft Install System w206

Durch scrollen kénnen Sie den kompletten Text sichten.
Bestatigen Sie mit “Annehmen” um fortzufahren.
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Nachfolgend kénnen Sie auswahlen, welche Komponenten installiert werden sollen.

I'll:l:'! Digital Dictation Installation: Installations-O o ]

_ Wahlen Sie die Komponenten aus, die Sie installieren machten und wahlen
Sie digjenigen ab, die Sie nicht installieren wollen. Klidken Sie auf Weiter,
um fortzufahren.

Wahlen Sie die Komponenten
aus, die Sie installieren machten: Digital Dictation for Winamp
Digital Dictation Pitch Control

Bendtigter Speicher: 140.0KB

Abbrechen | Mullsaft Inskall System v, 06 < Zuriick | Weiter = I

Wenn Winamp bereits installiert ist, kann dieser Punkt Gbersprungen werden.
Klicken Sie “Weiter >".
Digital Dictation wird in das unten angegebene Verzeichnis installiert. Wir empfehlen, in

diesem Fenster keine Anderungen durchzufiihren, da Digital Dictation andererseits nicht
korrekt installiert wird.

I'h:'! Digital Dictation Installation: Zielverzeichnis o ]

| Digital Dictation wird in das unten angegebene Verzeichnis installiert. Falls
Sie in ein anderes Verzeichnis installieren machten, kicken Sie auf
Durchsuchen und wéhlen Sie ein anderes Verzeichnis aus. Klidken Sie auf
Installieren, um die Installation zu starten.

C:\Programme winamp ins\ Durchsuchen... |

"Eeluerzeimnis

Bendtigter Speicher: 140.0KE
Verfiigharer Speicher: 24,4GE

Abbrechen | Mullsaft Inskall Syskenm w208 < Zurtick | Insbllierenl

Klicken Sie “Installieren”.
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Winamp Installation Lizenzabkommen (License Agreement):
ii.gWinampEpetup =10 =|
License Agreement
W]mmp Please review the license terms before installing Winamp.

Please read and agree to the license terms above before instaling.

WINAMP PLAYER LICEMSE AGREEMENT ﬂ

BY CLICKING THE ACCEPTANCE BUTTOMN OR INSTALLING OR USIMG THE WINAMP
SOFTWARE, YOU AGREE OM BEHALF OF YOURSELF AMD THE ENTITY YOU REPRESEMT
(IF APPLICABLE) THAT YOU OR SUCH ENTITY ARE BOUND BY, AND ARE BECOMING A
PARTY TO, THIS AGR.EEMENT AS THE "LICEMSEE. " IF YOU OR THE ENTITY YOU
REPRESEMT, AS APPLICABLE, DO MOT AGREE TO ALL OF THE TERMS OF THIS
AGREEMENT, ¥OU MUST SELECT THE CAMCEL BUTTOM, YOU MUST MOT IMNSTALL OR
IISE THE SOFTWARE, AMD YOU OR. THE ENTITY YOU REPRESENMT, AS APPLICAELE, DO
MOT BECOME A LICEMSEE UMDER. THIS AGREEMENT.

=l

If you accept the terms of the agreement, dlick I Agree to continue. You must accept the
agreement to install Winamp.

rullsoft Install System —- built on 3262004 at 113858 &6

I Agree I Cancel

Klicken Sie “I Agree”.

Die néchste Ansicht zeigt Installationsoptionen. Wir empfehlen, keine Anderungen
durzufihren.

iiE'—'-WinampSetup ol =
Choose Components
m Choose which features of Winamp you want to install.

This will install Winamp 5.03. This installer contains the lite install.

Select the type of install: Lite -

Cr, select the optional o Winamp (required)
;';LT"EHE i Winamp Agent
‘ User Interface Extensions
+- Audio File Support
-- Visualization
#-[¥] Extra Audio Output/Effect Support

Space required: 1.5MEB

Mullsoft Install Systerm — built om 2/26/2004 &t 11:35:38 &

< Back I Mext = I Cancel

Klicken Sie “Next =>".
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Winamp Installation Folder:
wir empfehlen, in diesem Fenster keine Anderungen durchzufiihren, da Digital Dictation
andererseits nicht korrekt installiert wird.

m:-'- Winamp Setup o ] [
Choose Install Location
W]m Chaose the Falder in which bo install ‘Winamp.

Setup has determined the optimal location ko install. IF vou would like to change the directary,
do 5o mow,

Destination Folder

Browse. .. |

Space required: 1,5ME
Space available: 7.0GE

Miullsaft Install System -- built on & 262004 at 1153855 &

< Back I Mext = I Cancel

Klicken Sie “Next =>".

ilh:'! Winamp Setup o ] [
Choose Install Options
m Choose where toinstall Winamp icons and what media ko

associate with Winamp

Select which icons wou want installed, and whether wou want files and CDs associated with
\Winarnp,

Select icons ko install and

media associations: Deskkop Tcon

Quicklaunch Lcon

Swstem Tray Icon [ Agent

Associake with audio files

Associake with audio CDs

Associate with plavlist files (*,m3u,*.pls)

Mullsaft Inskall System - builk an 3/26/2004 &k 113535 &0

% Back I Mexk = I Cancel

Klicken Sie “Next =",
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Winamp wird installiert. Bevor die Installation abgeschlossen ist erscheint folgende Ansicht:
o B
Internet Connection 5ettings
mm Configure \Winamp's path bo the ouker world,

Internet conneckion:

Mok connected ko the internet j

Alwawvs connected (LAN, DSL, Cable)
Connected via dial-up (Modem
Mat connected to the inkernet

HTT]

[ Use prowy only For port 80 URLs

fdullsakt Install System -- built om 3/26/2004 &t 11:38:38 &M

< Back. I Inskall I Zancel

Wahlen Sie “Not connected to the internet” und klicken Sie “Install”.

Winamp ist installatiert. Kehren Sie nun zur Installation des Digital Dictation zurtick.

ip;—-'- Digital Dictation Installation: Fertig

Details anzeigen

Abbrechen | Mullsaft Inskall System w2, 06 = Zuriick Beenden

Klicken Sie “Beenden”.
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Wenn Sie den Winamp Installation folder geédndert haben, sollten Sie ebenfalls den Digital
Dictation Installation folder andern. Der Digital Dictation installation folder befindet sich in
dem plugins Verzeichnis des Winamp Installationsverzeichnisses.

Wenn Sie keinerlei Anderungen durchgefiihrt haben, klicken Sie , Install®.

I'h:'! Digital Dictation Setup: Installation Folder =100 ]

different folder, click Browse and select another Folder, Click Install o start

@ Setup will install Digital Dickation in the Following Folder. To install in a
the installation,

I Z:\Program FilesiwinampPlugins Browse. .. |

"Destinatian Falder

Space required: 140,0KE
Space available: 3.3GE

Cancel | tullsoft Install Systenm w2, 0bt < Back |

11
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3 DEINSTALLATION DIGITAL DICTATION

Um Digital Dictation zu deinstallieren klicken Sie:
Start -> Programme -> Winamp -> Uninstall Digital Dictation.

¥ Digital Dictation Deinstallation: Bestatigung -0l x|

Thig will uninstall Digital Dictation

Entferne aus: I C:\Programme winampPlugins’,

Abbrechen | Mullsafs Tnskall System w208 Ceinstallieren

Klicken Sie “Deinstallieren”.

il '3 Digital Dictation Deinstallation: Fertig 0] x|

il Fertig
‘3 EERRRRERRRRREEERERRREEEREEEEEEEN]

Details anzeigen |

AbGrechen | Mullsaft Inskall Sysbem v 2. 06 = Zutiick ” Beenden I

Klicken Sie “Beenden*. Digital Dictation wurde von lhrem System entfernt.
Deinstallieren Sie nun den Winamp Player.
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Um Winamp zu deinstallieren klicken Sie -> Programme -> Winamp -> Uninstall Winamp

@ winamp Uninstall: Confirmation x|
T hiz will uningtall Winamp. Continue?

Ininztalling from: |C:4Program Files'finamp

Cancel | Mullzaft [rstall Systenm 1. 45 < Back  Hewty

Klicken Sie “Next =>".

Winamp fragt nun, ob alle plug-ins und skins entfernt werden sollen:
Bestatigung mit “JA*.

=

Files in C:\Program Files!Winamp were nok removed,

‘? y
\4\") Remove all files?

(If wou have skins or plug-ins that you wish to save, select NO)

Uninstall complete:

5 wimamp Uninstall ST

1 } Uninstall complete

Klicken Sie “ok” und schlieRen Sie das Programm mit “close”.
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4 DIGITAL DICTATION BEDIENUNGSANLEITUNG

Starten Sie das Programm: Start -> Programs -> Winamp -> Winamp

Winamp wird getffnet:

e 2.7sc |
_l kbps _l kHz mona St

[ . [ T

| RN .

Die folgenden Fenster werden nicht benétigt und kénnen geschlossen werden.

Minibrowser:
WINAMP EROWSER

Winamp

HMP3 Internet Radiao

your Winamp a hew look and

4dd to .
odd lity Lo play new
filES; 1|_:|. more!

| | o = (T 0F L Aile rogram Fileshifinampasinampmb. b

Winamp Equalizer:
* WINAMP EQUALIIER

— g — +20dh —

WINAMP PLAYLIST

-B-+0de -BA-B -

— 0 _ apgp -
FRERHF HI |"||

14
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Wahlen Sie Uber die eject “Taste” (rot markiert) die gewiunschte Datei an:

s E——

T —
I-:I:-|:-= _ll-:Hz mono  Sterms
e s TN e [0 [ TR

O U O O B s

Im Standard Windows Open File Menu Datei anwahlen und “Offnen®.
Arbeiten Sie nun mit dem FuRpedal.

Folgende Funktionen werden unterstitzt:
e Wiedergabe / Stop
e Schneller Rucklauf
e Schneller Vorlauf
e Lautstarkeregelung

4.1 Das mittlere Pedal
Das mittlere FuRRpedal startet die Wiedergabe der Audiodatei:

Fur Wiedergabe das Pedal gedriickt halten. Bei Loslassen des Pedals wird die Wiedergabe

gestoppt. Wird das Pedal erneut gedriickt, beginnt die Wiedergabe um eine Sekunde zuriick-
versetzt.

15
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4.2 Das linke Pedal
Das linke Pedal aktiviert den Rucklauf oder ermdglicht die Lautstarkeregelung (Absenkung):

Einmal drticken: die Wiedergabe beginnt um 5 Sekunden zurtckversetzt,
Gedriickt halten: schneller Rucklauf.

Mit dem Befehl CTRL und Dricken des linken Pedals kann die Lautstarke abgesenkt
werden.

4.3 Das rechte Pedal

Das rechte Pedal aktiviert den Vorlauf oder erméglicht die Lautstarkeregelung (Anhebung):

Einmal driicken: die Wiedergabe beginnt um 5 Sekunden vorversetzt,
Gedriickt halten: schneller Vorlauf.

Mit dem Befehl CTRL und Driicken des rechten Pedals kann die Lautstarke angehoben
werden.

16
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5 WINAMP FUNKTIONEN

Winamp bietet vielfaltige Anwendungsmaoglichkeiten:
| Start

| = stop

IE Vorheriger Track
Bl Nachster Track

Ir Pause

Scrollen.

Lautstarke.

Winamp bietet die Option “plug-ins” zu installieren. Wir empfehlen jedoch, dieses nicht zu
tun, da einige dieser “plug-ins*“ mit Digital Dictation in Konflikt treten kdnnten.

Vorschlage

1. Sie kébnnen Winamp so einrichten, daR es jeder Zeit sichtbar ist (“always on top”-

Funktion): Klicken Sie mit der rechten Maustaste auf das Winamp logo und
wahlen Sie Options -> Always On Top, oder gehen Sie tUber Control-A.

2. Winamp verkleinern: Klicken Sie shade (IEEld) in der oberen rechten Ecke. Winamp
wird wie folgt angezeigt:

[ % WINAMP = s=---_.= - HEHENA: Jw® =

17
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6 DIGITAL DICTATION TPS CONTROL

Ab Version 1.1 bietet Digital Dictation die Moglichkeit die Funktionen TPS (Tempo, Pitch und
Speed) des Audiomaterials zu veréndern. Hiermit kann die Audioqualitat optimiert werden.

Digital Dictation

Iempcug
Pitch

T,

Speed

Digital Dictation TPS Conkral Reset

So aktivieren Sie TPS Control:

Klicken Sie mit der rechten Maustaste auf das Winamp Icon: .
Wahlen Sie: Options -> Preferences:

Winamp Preferences ﬂ

- Setup — DSP/Efrect plug-in

- File types

- Bugent

- Optionz

- Dizplay

- YWizualization
- Shuffle

- Plug-inz

- [rput

- Qutput

- YWizualization
= [SP/Effect
- General Purpose
- Sking

- Bookmarks

Drigital Dictation TPS Control +1.0  [dep DigitalDictation.

| Digital Dictation TPS Contral +1.0 =l

I Configure | Get plug-inz

Cloze

Unter Plug-ins: DSP/Effect wahlen Sie Digital Dictation TPS Control.

18
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/7 PROBLEMLOSUNG

Sollten Probleme auftreten, prifen Sie bitte folgende Punkte:

- Unterstuzt Ihr Computer USB? Digital Dictation bietet nur Support fir Microsoft
Windows 2000 und Microsoft Windows XP.

- Ist das FuBBpedal richtig angeschlossen? Bitte Uberprifen Sie die USB-
Steckverbindung.

- Sind Sie den einzelnen Bedienschritten in der Bedienungsanleitung korrekt
gefolgt?

Ist Ihr Problem nicht behoben, kénnen Sie unter: www.dig-dictation.com umfangreichere
Informationen zu Fehlermeldungen erhalten.

Wenn Sie uns kontaktieren méchten, halten Sie bitte folgende Informationen bereit:

- Die Seriennummer des FuBRpedals (auf der Rickseite des Fulipedals befindlich)
- Die Versionsnummer lhrer Digital Dictation Software

Die Versionsnummer von Winamp erhalten Sie Uber: Options -> Preferences... -> Plug-
ins -> General Purpose:

Winamp Preferences El

- Setup — General purpoze plug-ns [loaded at startup]

- File hypes Dvigital Dictation »1.0
- Agent

- Optiohs

- Digplay

- Wisualization
- Shuffle

- Plug-ing

- | Fipt

- Dukput

- Wisualization
- DSP/Efect

&% General Purpose
- Sking
- Bookmarks

Configure U nirztall Get plug-ins
Cloze I

Die angezeigte Nummer hinter Digital Dictation ist die Versionsnummer.
In diesem Fall: Version 1.1.
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